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UNIVERSITY OF NORTH TEXAS 

Department of Geography 
 

GEOG 3100: US and Canada – Cities, Economies, and Sustainability 
 

Group GIS Exercise: Residential Development and 

Service Availability in Hillsborough County, Florida 
 

In this group exercise, we will use the Maptitude GIS software package to introduce some 

capabilities of geographic information systems as they can be used to assist geographers in 

understanding and solving problems in urban communities. 
 

In this exercise, you will analyze geographic markets using detailed business and geographic 

datasets and the Maptitude software. Your overall goal with this analysis: to analyze a troubled 

residential development using the power of geographic analysis. 

 
 

The scenario: you are a GIS analyst for Hillsborough County, Florida (the county that includes the city of 

Tampa). Your job is to assess community characteristics and needs across the county to support local 

planners and developers.  Your focus as GIS analyst is to provide insights based on your expertise in 

geography and in the Maptitude GIS software. 
 

Your specific task here is to analyze the situation of the Carriage Pointe residential development in 

Hillsborough County, located eight miles south of downtown Tampa. Carriage Pointe is a neighborhood 

that was hard hit by recent economic downturns (many housing foreclosures, home abandonments, and a 

high inventory of unsold houses at the worst times). As a result, Hillsborough County is working with other 

local governments and developers to better understand neighborhoods like Carriage Pointe. The goal is to 

identify factors that may have contributed to the neighborhood’s issues (and help developers to avoid 

repeating these problems in the future). 
 

 

____________________________________________________________________________________________________________________ 
 

Exercise Credit: Dr. Murray Rice created this urban analysis exercise using geographic files and software provided 

by Caliper Corporation, publishers of the Maptitude GIS package.  
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Key Features of this GIS Exercise 
 
 
There are three key features that you will find in this GIS exercise. 
 

1. Tasks and Steps 
 

The exercise is divided into tasks (major milestones that collectively build to achieve the overall 
exercise goals) and steps (minor milestones that need to be completed to finish each task). 

 

2. Rough Notes 
 

While some steps (as defined above) are simply activities you need to do in your analysis, a few 
steps are flagged as being “rough notes”. As already highlighted on the previous page, each 
rough note request is highlighted in bold text. These rough notes are steps where something 
needs to be recorded or saved. This might involve a brief, written note summarizing or giving your 
interpretation of something you just did or found out from your GIS analysis (please record these 
notes in a Word document). Or, a rough note may involve simply saving a map you have produced 
through your GIS work. 
 

Please label each of these rough note responses using the task and step number associated with 
the bolded question you are answering – e.g. “Task 1, Step 1a”. All rough note material must be 
completed and submitted together in a separate “rough notes” document, but you need to 
understand that these notes are primarily for your reference and are not the ultimate product for 
the exercise. Lastly, please note that most steps in each task do not require that you record 
anything at all, although you will still need to complete every step in each task to complete the 
exercise. 

 

3. Final Report 
 

This exercise concludes with a final challenge – create a concise document (no more than 4 
pages plus supporting map material) that includes the following five sections: 
 

• An exercise scenario description (summary of the Tampa Bay area situation outlined 
here), 

• The question to be solved (this can be brief, but it needs to define the central problems 
addressed in the exercise), 

• The analytical approaches used (the GIS techniques you use to produce your results), 

• The results you obtained (including relevant maps and other results/insights extracted 
from your “rough notes”), and finally (and most meaningfully) 

• A concise and impactful summary of the application of your work to the decision-makers 
you are supporting. 

 

This final report can and should draw on the raw material (answers, comments, maps) you 
assemble in your rough notes, but you need thoughtfully assess which material to include (not all 
of this material will make it), and you need to use all of the writing skill you have to create a 
compelling and concise narrative that gives only the necessary information. 
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Before you begin this location analysis exercise, here are two more important notes: 
 

1. Maptitude is a desktop software package that runs on your CSAM lab computer. This means that 

Maptitude uses storage space on your computer for all files being used and created in the course of 

your analysis. You would be wise to store all maps and other files you create on your own portable 

storage device, such as a flash drive or other portable electronic media: this will enable you come 

back to complete or modify your work later without re-doing your work. 
 

2. Please provide “rough note” results or answers (using complete sentences) or other material 

(maps, graphics) for any text printed in bold. To help you see these rough note steps, this 

instructions document also marks rough note steps with an arrow symbol, like the one shown here: 
 

 
 

 
 

 

Task 1: Identifying and Mapping the Carriage Pointe Location 
 

1. To complete this assignment, you will need to start up two software packages: 

 

a. Microsoft Word, installed on the computers in our CSAM lab room. Start this 

software and create a blank Word document named “Exercise-

RoughNotes.docx”. 

• As you work today, you will collect maps and notes from throughout 

your work session in this Word document. 
 

b. Maptitude GIS software, installed on the computers in our CSAM lab room. 

When you have started Maptitude, select the following “Home” page dialogue 

will appear. Select the “New map of United States” option and click on the 

“OK” button as highlighted below: 
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2. Selecting the New Map option starts the “Create-a-Map” Wizard. Choose “Create a United 

States map” and “U.S. City” from the available options, and type “Gibsonton, FL” as the 

name of the city to map (Carriage Pointe is a community in Gibsonton). When you have 

done this, click on the “Finish” button. 
 

 
 

 

3. After you have entered this information, Maptitude will tell you the map is ready to view. 

The map you have created will look something like this (yours may look slightly different). 

The area highlighted in red in this map graphic (here, but not on your Maptitude screen) is 

the Carriage Pointe community that is the principal focus of the rest of your analysis. 
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This Gibsonton/Carriage Pointe map is useful because it gives us a foundation to analyze 

the geographic context for the Carriage Pointe community, including the region that 

provides jobs, education, shopping, and recreation opportunities for the people who live in 

Carriage Pointe. 

 

 

 

4. Now, let’s go through a quick process to identify and save a point location representing the 

center of this neighborhood for further analysis. 

 

(a) From the “Tools” menu in the menu bar across the top of your Maptitude screen, select 

the “Editing” submenu. In this submenu select the “New Layer” dialogue box (again, 

the menu hierarchy is “Tools” → “Editing” → “New Layer”). In the resulting dialogue 

box, select the following options 

 

• Type of File: Point Geographic File 

• Name: “Carriage Pointe” 

• Options: “Add the layer to the current map window” 

 

When you have completed the preceding settings, the dialogue box should look something 

like the below. With this done, click “OK”. 
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(b) Simply click “OK” on the next dialogue box (which provides database options we 

won’t use here): 

 

 
 

(c) And finally save the location file with this last dialogue box. Save to your Desktop and 

name the file “Carriage Pointe”, file type “Geographic File (*.dbd)”: 

 

 
 

(d) Click on “Save” in the above dialogue box to finish the creation of this file. 
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5. With the geographic file created, we need to store the location for the Carriage Pointe 

community in the file. 

 

(a) Activate the “Layer Editing Toolbox” by going to the “Tools” menu, “Editing 

submenu, “Layer Editing Toolbar” option (“Tools” → “Editing” → “Layer Editing 

Toolbar”) 

 

(b) In the Layer Editing Toolbar, click on the “Add Point” tool highlighted below (tool 

with green cross): 

 

 
 

(c) With the Add Point tool activated, click on a location near the center of the Carriage 

Pointe community (the zone highlighted in red in the map shown at task 1, step 4 – see 

bottom half of page 4 in this instructions document). The precise location you choose 

for this point is not important – anywhere near the center of the community will be fine. 

Doing this will add the new community center point to the map. 

  

(d) Click on the “green light” button in the Map Editing Toolbox to save this single new 

Carriage Pointe location. 
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6. As this community center point dot stands, it is just a small black dot that is a little hard to 

see. However, we can adjust this dot type for easier viewing. 

 

(a) Find the Carriage Pointe location file in the Display Manager area (see this bar, located 

on the left side of the Maptitude screen). The Carriage Pointe layer is highlighted in 

blue below: 
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(b) Click on the dot symbol in the Carriage Pointe line (immediately left of the “Carriage 

Pointe” layer name, as shown below) to adjust the symbol type for improved visibility. 

As it stands, the default dot is small and hard to see. I suggest increasing the dot size at 

very least, but you decide what works best for you (see the dot type, size, and color 

options you have available). 

 

Click on dot symbol shown below to bring up the 

“adjust dot style” dialogue box: 

 
_______ 

 

Resulting “dot style” dialogue box 

(provides several dot display options): 

 
 

(c) Change the dot type, size, and color as you see fit. When you are satisfied with the 

visibility of your dot style, click on “OK” in the style dialogue box. The map will be 

updated to show your new Carriage Pointe location dot. 
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7. Your last step in this map creation is to use the main Maptitude map toolbox to adjust the 

geographic zoom level of your map. Here is where you can find the map zoom tools (zoom 

in and zoom out) in the main map tool box: 
 

 
 

The basic idea here: aim for a map something like the below that covers the broad Tampa 

Bay/St. Petersburg metropolitan region, and shows the location of Carriage Pointe within 

this larger region. 
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8. Rough Notes Step: Take the map as you have it now and copy and paste it into the 

“rough notes” Word document you are developing (remember this is the Word 

document you started in task 1, step 1a on page 3). 

• When you paste the map into your Word file, please place the map code 

"task1step8" immediately underneath this map in the Word document. To be 

clear, what we’re aiming for with this map/map code combination is something 

like this in your Word document: 

 

 
task1step8 

 

• Please ask if you have any questions about completing this step. 
 

 

 

 

 

 

 

9. Rough Notes Step: Referring to the map you have created, use words to describe the 

location of Carriage Pointe within the context of the Tampa metropolitan area. What 

can you say about this neighborhood’s location? Is it close to the main downtown 

areas? (see the location of the “Tampa” and “St. Petersburg” labels) Overall, do you 

any strengths of the Carriage Pointe location? Weaknesses? Answer in one, good 

paragraph. 
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Task 2: Preliminary Geographic Analysis of Carriage Pointe’s 

Location 
 

After mapping the location of Carriage Pointe, the next step in the analysis is to bring in 

information to define the local area that the Carriage Pointe community both impacts and is most 

impacted by. Maptitude provides some powerful tools to define such a local zone. In this section 

of the exercise, we will focus on something called a “drive time zone”: the geographic area that 

can be reached within a given driving time of a given location. 

 
 

1. Rough Notes Step: What impact might the construction of a new residential 

community have on what is already happening in its surrounding area (e.g. schools, 

stores, community services)? How might a residential community be impacted (for 

good or for bad) by the land uses and activities already present in the area around it? 

Answer these two related questions in two good paragraphs (one paragraph for each 

question). 

 

2. Rather than giving further detailed, step-by-step instructions here on how to complete the 

drive time zone analysis for our Carriage Pointe study, I will point you to two resources: 

the Maptitude Help Feature, and the Maptitude Video Tutorials. Both of these resources 

provide the information you need to complete the drive time zone analysis. The 

descriptions below show how to access and use these great resources. You do not have to 

access all the resources highlighted here: just refer to as much as you need to understand 

how to complete the needed geographic analysis. 
 
 

A. The Maptitude Help Feature. This program help feature covers every GIS function 

provided by Maptitude, including many not explored in this exercise. The guide is available 

from within Maptitude. You can access this user guide from Maptitude’s “Help” menu as 

shown below: 
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You can browse this help guide, or you can search for a specific topic. For an 

excellent overview of all drive time analysis options, search for drive time analysis 

in the search box highlighted here: 

 

 
 

The search results bar on the left side of the help screen gives you links to the best 

help content for your search. Your drive time help topic search gives you something 

like the below. Click on the first “Creating Drive-Time Rings” link there. 

 

 
 

You will find an extensive description of Maptitude’s drive-time rings GIS function 

and how to use it. 
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B: Maptitude Video Tutorials. Written descriptions are good for some people, but others 

like hands-on demonstrations. An extensive collection of useful, step-by-step 

demonstration tutorials are available on the Maptitude website. 
 

The page linking to all Maptitude video tutorials is located here: 
 

https://www.caliper.com/Maptitude/mapping-software-video-tutorials.htm 

  

 Here is the drive-time rings video tutorial link: 

 

 
 

https://www.caliper.com/video/maptitude/maptitude-drive-time-rings-

video/maptitude-drive-time-rings-video.html 
 

 

 

3. Use whatever information you find helpful from Maptitude’s help and video tutorials to 

become familiar with the drive time analysis, and implement this analysis using a 5-minute 

drive time zone around the single Carriage Point dot location you previously created. This 

zone represents the immediate, local area around Carriage Pointe. As you do this, select as 

a route type the “Fastest” option.  As a partial hint, if you have followed the procedure 

correctly, you should have set up the drive time dialogue box to look like this: 
 

 
 

https://www.caliper.com/Maptitude/mapping-software-video-tutorials.htm
https://www.caliper.com/video/maptitude/maptitude-drive-time-rings-video/maptitude-drive-time-rings-video.html
https://www.caliper.com/video/maptitude/maptitude-drive-time-rings-video/maptitude-drive-time-rings-video.html
https://www.caliper.com/video/maptitude/maptitude-drive-time-rings-video/maptitude-drive-time-rings-video.html
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4. Rough Notes Step: When you have completed the analysis, use the map tools (zoom 

in/out) to make any needed adjustments to the zoom level of the map and paste this 

map into your rough notes Word document (using the same process you used 

previously – see what you did in task 1, step 8). 

• Please place the map code “task2step4” immediately underneath this map. 
 

 

5. Rough Notes Step: Additionally, also save the base map as you have it here in 

Maptitude’s own “Workspace” format (so you can do further analysis later without 

having to recreate this map from the beginning). Using the “Save Workspace as” 

dialogue box, type the file name “Carriage Pointe Area With Drive Time” and save 

the map as type “Workspace - Compressed”.  

• You are doing this step only so you can come back to this map later if you need to  

(for your records only). This means you will not be submitting this workspace file 

as part of your lab. 
 

 
 

6. Rough Notes Step: please answer the following questions about the map. 
 

A. Describe the 5-minute drive time zone that Maptitude has generated for Carriage 

Pointe. What is the shape of this zone? What is your best explanation for why the 

zone has this kind of shape? Why isn’t the zone circular? Answer the above in one 

paragraph. 
 

B. Now that you see Carriage Pointe’s drive time zone, explain why it can be useful 

to identify such a drive time zone when trying to understand a neighborhood and 

its prospects for the future. Why could such a zone be a meaningful characteristic 

of a neighborhood? Answer the above in one paragraph. 
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Task 3: Add Community Services to the Analysis 
 

 

Our last analytical task is to add another level of detail to our location assessment. The key factor 

that we will investigate in this part of the project is the local status of community infrastructure: 

the location of businesses and community services around the Carriage Pointe development. Is it 

possible that the location and accessibility of community services in the area relates in some way 

to what has happened with Carriage Pointe? 
 

To do this analysis, we will look at two basic kinds of indicators: 
 

A. Wal-Mart Stores: Wal-Mart provides a broad range of food types and household goods. 

Commonly, Wal-Mart stores are surrounded by other businesses (stores, restaurants), so 

they are a good, overall indicator of the location of community services more broadly. 

B. Hospitals: a facility whose presence or absence in a region provides an indicator of the 

community’s local access to basic public services. Access to health care is one key measure 

of overall community status. 
 

Maptitude provides a suite of mapping capabilities that can provide a variety of perspectives on 

the locations of these two facility types. We will use two here: basic facility location mapping, and 

density grid mapping. 

 

1. To start this analysis, start with a blank screen in Maptitude (no maps or other files open). 

From the “File” menu, select “Open”, go to the directory where your “Carriage Pointe 

Area” map is stored, and select this map file for opening. For this to work, ensure that 

“Workspace” is the selected file type (as in the graphic below). 
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2. With this Carriage Pointe map open, let’s add our first facility layer: the Wal-Mart stores 

layer. To do this, go to the horizontal tool bar near the top of the Maptitude screen, and 

locate the “Map Layers” tool (highlighted below): 

 

 
 

Clicking on this map layers tool will bring up the dialogue box shown below. Click the 

“Add Layer” button and navigate to the CSAM lab “3100” directory already mentioned: 

 

 
 

 

3. When you’re in the “3100” directory, find, select, and open the “Wal-Mart” geographic 

file: you will find it in the “3100\Group Exercise\Location Data Files” subdirectory (see 

directory structure graphic below). Opening this Wal-Mart file will add the Wal-Mart store 

location layer to the map layer list shown above.  
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4. With the Wal-Mart layer added to your layer list, click on the “Style…” button to customize 

the look of the Wal-Mart symbol for maximum visibility (use your judgment – you can 

come back to this style dialogue again if you want to try different dot types). When you’re 

done with customizing the Wal-Mart dot type, click on the “Close” button in the layers 

dialogue box to see the Wal-Mart locations on your map. 

 

 
 

5. Rough Notes Step: Paste the map (with the Wal-Mart layers shown) into your rough 

notes Word document. Use the procedure you’ve already used to do this in previous 

steps. 

• Place the map code “task3step5” immediately underneath this map in your 

document. 

 

6. Rough Notes Step: With the Wal-Mart locations visible on your map, what do you 

observe? Is there a Wal-Mart within the 5-minute drive time zone for the Carriage 

Pointe development? Beyond the nearest Wal-Mart location, how convenient is the 

next-closest Wal-Mart, and other Wal-Mart store after that? What does this map tell 

us about how plentiful the shopping options are around the Carriage Pointe 

neighborhood? Use no more than two paragraphs to provide this discussion. 
 

_____________________ 
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7. With the Wal-Mart locations on the map, the next step is to create a “Density Grid” analysis 

of these store sites. Density Grid mapping is a powerful visual tool to indicate areas with 

extensive clustering, such as the stores we are analyzing here. As with the previous drive 

time analysis, you can find excellent Maptitude User Guide and Maptitude Video Tutorial 

resources to teach you how to do this analysis and use all relevant options. Again, just use 

whatever resources you need to become familiar with how to do the analysis. 

 

 

A. Maptitude Help Feature: an overview of density grid options can be found in Chapter 

10, beginning on page 294. 

 

 
 

 

B. Maptitude Video Tutorials: the Maptitude website has an excellent density grid (“hot 

spot”) tutorial that goes through every necessary step. 

 

 
 

https://www.caliper.com/video/maptitude/maptitude-density-grid-hot-spot-

video/maptitude-density-grid-hot-spot-video.html 

 

https://www.caliper.com/video/maptitude/maptitude-density-grid-hot-spot-video/maptitude-density-grid-hot-spot-video.html
https://www.caliper.com/video/maptitude/maptitude-density-grid-hot-spot-video/maptitude-density-grid-hot-spot-video.html
https://www.caliper.com/video/maptitude/maptitude-density-grid-hot-spot-video/maptitude-density-grid-hot-spot-video.html
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8. Use the help feature and/or video tutorial resources here to become familiar with the 

density grid analysis, and implement this analysis for the entire set of Wal-Mart store 

locations on your map. Note: for the “Set” setting, use “All Features”, and for the “Radius 

(Miles)” setting, enter a value of 5.0 miles, leaving all other settings as you find them (see 

sample graphic below): 
 

 
 

9. Rough Notes Step: When you have completed the density grid analysis, use the display 

manager to make any needed adjustments to the map and 

• Save the map as a Maptitude map file (*.map format) named “Carriage Pointe 

Area With Wal-Mart Density Grid.map”. This is only for your records (in case 

you need to come back to this map). 

• Copy and paste the map into your rough notes Word document (place the map 

code “task3step9” underneath this map). 
 

 

 

10. Rough Notes Step: Please answer the following questions about this Wal-Mart Density 

Grid map. 
 

a. What does this map add to your insight that the simple store location map did 

not provide? Answer the above in one paragraph. 
 

b. What observations can you make about the density grid pattern reflected in 

the map? Is the entire Tampa Bay/St. Petersburg region well-covered by Wal-

Mart stores? What is the store coverage like in the Carriage Pointe area? Be 

as specific as you can in describing and defining the patterns you see (place 

names, helpful terms). Use no more than two paragraphs to provide this 

discussion. 
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11. Rough Notes Step  

 

Rough Notes, Map Component: With the Wal-Mart store analysis complete (Wal-Mart 

locations mapped, and a density grid completed for these Wal-Mart locations), please save 

and close all current maps and repeat the same process with hospital locations: first map 

these hospital locations, and then construct a density grid for these hospital locations. 
 

Please note the following to help you complete these steps for the hospital analysis: 
 

• Begin this process by opening the Carriage Pointe Area base map referenced in Part 

3, Step 1 (page 16 of this document) 
 

• This time through the analysis process, your focus is on hospitals instead of Wal-

Mart locations. 
 

• You will find the hospital location file in the “Location Data Files” subdirectory 

you already accessed for the Wal-Mart file. 
 

• For this hospital location analysis, you will need to complete all Maptitude 

analytical steps listed in Part 3. These are steps: 1, 2, 3, 4, 7, and 8 (pages 16-20 of 

this exercise instruction document). 
 

• As you complete these steps, you will need to copy some maps into your rough 

notes Word document:  
 

o After Step 4: (when you only have the hospital dots on your map), copy 

and paste the hospital location map into your rough notes Word 

document (use map code “task3step11a”). 
 

o After Step 8: copy and paste the hospital density grid map into your 

rough notes Word document (use map code “task3step11b”). 

 

Rough Notes, Question Component: Please answer the following questions with 

reference to the hospital location map. 
 

With the hospital locations on your map, what do you observe? Is there a hospital 

within the 5-minute drive time zone for the Carriage Pointe development? How 

convenient overall is access to hospital services from Carriage Pointe? What does this 

map tell us about how plentiful the healthcare options are around the Carriage Pointe 

neighborhood? Use no more than two paragraphs to provide this discussion. 
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12. Rough Notes Step: Please answer the following questions about the hospital density grid 

map. 
 

a. What does this map add to your insight that the simple hospital location map 

did not provide? Answer the above in one paragraph. 
 

b. What observations can you make about the service provision pattern reflected 

in the density grid map? Is the entire Tampa Bay/St. Petersburg region well-

covered by hospital services? What does the density grid map indicate about 

hospital coverage in the Carriage Pointe area? Be as specific as you can in 

describing and defining the patterns you see (place names, helpful terms). Use 

no more than two paragraphs to provide this discussion. 

 

 

 

 

Putting it All Together: The Final Report 
 

The final report for each exercise must include the following components (please label each of the 

following five sections in your final report with a clear and prominent heading): 
 

1. Scenario: a summary of the scenario situation, including your role, your geographic 

location in the scenario, and what is happening in that place 

2. Question: the key issue within the overall situation that needs to be solved or addressed 

3. Analysis: the GIS activities you used to complete the exercise 

4. Results: what you found out (insights obtained) 

5. Application: what good does it do for you to have done this work (how your employer can 

use what you found) 
 

Remember that this report should be no longer than 4 pages (but this 4 page limit is for text only, 

and does not include maps). As you prepare to write this final report, review the steps you took for 

each analysis and all of your rough notes. As you prepare to write the application section of your 

final report, consider the following: 
 

• Take time to carefully examine all of the information you have assembled in the preceding 

steps. Recall the scenario you started with, the question or problem you were addressing, 

the GIS activities you completed, and the observations you have made. Now is the time 

when you must explain all of this information in a concise, clear document.  
 

• Summarize the overall picture you are seeing with regard to Carriage Pointe and the 

community’s local service infrastructure: what do you see, what do you think it means, and 

what might you recommend to avoid problems like Carriage Pointe has faced in other 

developments in the future? You are reviewing what you have provided in the previous 

parts and steps, so there won't be any new findings here. However, how you put it all 

together won't be a simple repeat of what you've already said: 
 

o Like a courtroom lawyer, build your case and convince the reader with a clear and 

persuasive summary and assessment of your complete set of findings.  
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To Submit this Group GIS Exercise: 

 
1. Ensure all of your rough note question responses (for all steps highlighted in bold) are 

typed into a single Word document named “Exercise-RoughNotes.docx”. Please place your 

responses in order (by task and step number) within this file. Each question response should 

begin with a heading giving the task and step number to which the response refers (e.g. 

“Task 1, Step 1a”). 

2. Collect all of the map files requested in this assignment (from the steps where you were 

asked to save a file, and you were given a file name to save under). 

3. Complete your final report and save in a single Word document named “Exercise-

FinalReport.docx”. 

4. Attach all of the above material (your rough notes file, your map files, and your final report 

file) to a single e-mail to be sent to my email address (rice@unt.edu). Please make the e-

mail subject line “Last Names of People in Group – GEOG 3100 Exercise” (e.g. 

“Anderson Jones Smith – GEOG 3100 Exercise”). 

 

 

 

mailto:rice@unt.edu

